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Preface

Manual Information

Purpose
This manual details the features, installation, operation, maintenance,
and specifications for the VSM6801+ Serial Monitoring Distribution
Amplifier.

Audience

This manual is written for engineers, technicians, and operators
responsible for installation, setup, maintenance, and/or operation of the
VSM6801+ Serial Monitoring Distribution Amplifier.

Revision History

Table P-1. Revision History of Manual

Edition | Date Comments

A December 2007 Initial release

VSM6801+ Installation and Operation Manual vii
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Writing Conventions

To enhance your understanding, the authors of this manual have
adhered to the following text conventions:

Table P-2. Writing Conventions

Term or P

Convention Description

Bold Indicates dialog boxes, property sheets, fields, buttons,
check boxes, list boxes, combo boxes, menus,
submenus, windows, lists, and selection names

Italics Indicates E-mail addresses, the names of books or
publications, and the first instances of new terms and
specialized words that need emphasis

CAPS Indicates a specific key on the keyboard, such as
ENTER, TAB, CTRL, ALT, or DELETE

Code Indicates variables or command-line entries, such as a
DOS entry or something you type into a field

> Indicates the direction of navigation through a hierarchy
of menus and windows

hyperlink Indicates a jump to another location within the
electronic document or elsewhere

Internet address Indicates a jump to a Web site or URL

= Indicates important information that helps to avoid and

= Note troubleshoot problems

Obtaining Documents

Product support documents can be viewed or downloaded from our
website. Alternatively, contact your Customer Service representative to
request a document.

viii VSM6801+ Installation and Operation Manual
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Unpacking/Shipping Information
Unpacking a Product

This product was carefully inspected, tested, and calibrated before
shipment to ensure years of stable and trouble-free service.

1. Check equipment for any visible damage that may have occurred
during transit.

Confirm that you have received all items listed on the packing list.
Contact your dealer if any item on the packing list is missing.
Contact the carrier if any item is damaged.

a M e

Remove all packaging material from the product and its associated
components before you install the unit.

Keep at least one set of original packaging, in the event that you need to
return a product for servicing.

Product Servicing

Except for firmware upgrades, VSM6801+ modules are not designed
for field servicing. All hardware upgrades, modifications, or repairs
require you to return the modules to the Customer Service center.

Returning a Product

In the unlikely event that your product fails to operate properly, please
contact Customer Service to obtain a Return Authorization (RA)
number, then send the unit back for servicing.

Keep at least one set of original packaging in the event that a product
needs to be returned for service. If the original package is not available,
you can supply your own packaging as long as it meets the following
criteria:

e The packaging must be able to withstand the product’s weight.
e The product must be held rigid within the packaging.

e There must be at least 2 in. (5 cm) of space between the product and
the container.

e The corners of the product must be protected.

Ship products back to us for servicing prepaid and, if possible, in the
original packaging material. If the product is still within the warranty
period, we will return the product prepaid after servicing.

VSM6801+ Installation and Operation Manual iX
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Restriction on Hazardous Substances (RoHS)

Compliance

Directive 2002/95/EC—commonly known as the European Union (EU)
Restriction on Hazardous Substances (RoHS)—sets limits on the use of
certain substances found in electrical and electronic equipment. The
intent of this legislation is to reduce the amount of hazardous chemicals
that may leach out of landfill sites or otherwise contaminate the
environment during end-of-life recycling. The Directive, which took
effect on July 1, 2006, refers to the following hazardous substances:

e Lead (Pb)

e Mercury (Hg)

e Cadmium (Cd)

e Hexavalent Chromium (Cr-V1)

» Polybrominated Biphenyls (PBB)

e Polybrominated Diphenyl Ethers (PBDE)

According to this EU Directive, all products sold in the European Union
will be fully RoHS-compliant and “lead-free.” (See our website for
more information on dates and deadlines for compliance.) Spare parts
supplied for the repair and upgrade of equipment sold before

July 1, 2006 are exempt from the legislation. Equipment that complies
with the EU directive will be marked with a RoHS-compliant emblem,
as shown in Figure P-1.

RoHS
Compliant

Figure P-1. RoHS Compliance Emblem
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Waste from Electrical and Electronic
Equipment (WEEE) Compliance

The European Union (EU) Directive 2002/96/EC on Waste from
Electrical and Electronic Equipment (WEEE) deals with the collection,
treatment, recovery, and recycling of electrical and electronic waste
products. The objective of the WEEE Directive is to assign the
responsibility for the disposal of associated hazardous waste to either
the producers or users of these products. As of August 13, 2005, the
producers or users of these products were required to recycle electrical
and electronic equipment at end of its useful life, and may not dispose
of the equipment in landfills or by using other unapproved methods.
(Some EU member states may have different deadlines.)

In accordance with this EU Directive, companies selling electric or
electronic devices in the EU will affix labels indicating that such
products must be properly recycled. (See our website for more
information on dates and deadlines for compliance.) Contact your local
sales representative for information on returning these products for
recycling. Equipment that complies with the EU directive will be
marked with a WEEE-compliant emblem, as shown in Figure P-2.

Figure P-2. WEEE Compliance Emblem

VSM6801+ Installation and Operation Manual Xi
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Safety

Carefully review all safety precautions to avoid injury and prevent
damage to this product or any products connected to it. If this product is
rack-mountable, it should be mounted in an appropriate rack using the
rack-mounting positions and rear support guides provided. It is
recommended that each frame be connected to a separate electrical
circuit for protection against circuit overloading. If this product relies
on forced air cooling, it is recommended that all obstructions to the air
flow be removed prior to mounting the frame in the rack.

If this product has a provision for external earth grounding, it is
recommended that the frame be grounded to earth via the protective
earth ground on the rear panel.

IMPORTANT! Only qualified personnel should perform service
procedures.

Safety Terms and Symbols in this Manual

WARNING
A Statements identifying conditions or

practices that may result in personal injury
or loss of life. High voltage is present.

CAUTION
A Statements identifying conditions or

practices that can result in damage to the
equipment or other property.
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Chapter 1
Introduction

Overview

The VSM6801+ is a single-channel serial monitoring distribution
amplifier. It combines the functions of an equalizing, reclocking serial
distribution amplifier, and a 4:2:2 to NTSC/PAL converter of a single
channel.

The following topics are described in this chapter:
e “Product Description” on page 2

e “Module Descriptions” on page 3

e “Signal Flow” on page 7

VSM6801+ Installation and Operation Manual 1



Chapter 1: Introduction

Product Description

The VSM6801+ monitors one serial digital video 4:2:2 isolated input.
The SDI input has four corresponding composite outputs and four
corresponding copy outputs that are equalized and reclocked.

You can set up, control, and monitor the VSM6801+ either locally via
card-edge switches or remotely on a PC. For remote control, you can
use either a serial RS-232 or optional ICE6800+ or 6800+ETH
Ethernet connection.

Other VSM6801+ features include the following:

* SMPTE 259M-C/270 Mbps compatible

» Automatic or user-selectable standard mode NTSC/PAL-B
e Vertical blanking (pass/delete)

e Setup on/off option (NTSC only)

e Local gain control

»  Burst and chroma on/off

« Encoder with 10-bit DAC and 8-bit input data path

* Build-in color bar test signal through local or remote

« Status LEDs with signal presence indicators

2 VSM6801+ Installation and Operation Manual



Chapter 1: Introduction

Module Descriptions

Front Module

See Figure 1-1 for an illustration showing a partial top view of the
VSM6801+ module, and the general location of LEDs, switches, and

jumpers.
Manual/
; automatic
DIP Gain pot selection
switches Jumper
i Local/remote
control
jumper
B, gl
g 10700
Module
status Channel Extractor
LEDs LEDs handle

Figure 1-1. VSM6801+ Front Module

VSM6801+ Installation and Operation Manual 3



Chapter 1: Introduction

For a brief description of the general VSM6801+ LEDs, switches, and
jumper, see Table 1-1. See Chapter 3: “Operation” for more information
on specific VSM6801+ front module controls.

Table 1-1. Generic 6800+ Front Module Features

Feature

Description

Module status
LEDs

Various color and lighting combinations of these LEDs
indicate the module state. See “Module Status LEDs” on
page 23 for more information.

DIP switches

The module has one bank of DIP switches that has five
individual switches that allow you to adjust the
composite output from the module. See “DIP Switch
Functions” on page 20 for a list of DIP switch functions.

Channel LEDs

Each DIP switch has a corresponding LED. When the
module is in local control mode, the LEDs indicate the
DIP switch settings. When the module is in remote
control mode, the LEDs indicate the settings currently
applied to the module. See “Channel LEDs” on page 22
for a description of these LEDs.

Gain pot control

Composite output has a corresponding gain pot control.
(This control is factory set.)

Local/remote
control jumper

» Local: Locks out control by external control panels
and software applications; allows card-edge control
only. However, the module’s status can still be
monitored remotely.

* Remote: Allows remote configuration, operation, and
monitoring of the VSM6801+.

VSM6801+ Installation and Operation Manual



Chapter 1: Introduction

Back Connectors

FR6802+ Frame Back Connectors

Figure 1-2 shows the single-slot (VSM6801+SR) and double-slot
(VSM6801+DR) back connectors that can be used with the VSM6801+
module when it is installed in an FR6802+ or FR6802+QXF frame.

SDIIN 1 SDIIN 1
CMPST 1 SDIOUT3 CMPST1
CM;;T 2 CMPST3 CMPST 2

@1 @ @
SDI OUT SDIOUT 4 SDIOUT1

Figure 1-2. Back Connectors for the FR6802+ Frame

6800/7000 Series Frame Back Connector Overlays

— Figure 1-3 shows the single- and double-slot back connector overlays
ﬁ,/»; Note used for the VSM6801+ when installed in a 6800/7000 series frame.

Remote control for this 6800+
module is not available if it is
installed in a 6800/7000 series
frame.

VSM6801+ Installation and Operation Manual 5
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%)
o

%)
9
o
c

o

N1

19:@

CMPST 2

@

=

SDIIN 1
SDIOUT3 CMPST1

Figure 1-3. Back Connector Overlays for 6800/7000 Series

Frame
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Chapter 1: Introduction

Signal Flow

SD-SDIin (o)

P 0) SD-SDI out 4

- Analog composite

v video out 1
g Analog composite
| . .

) Serial Filter & video out 2

Equalizer decoder —»| Encoder [P buffer .
»( o Analog composite
i video out 3
g Analog composite
v video out 4
Midplane
110

P CCS remote
monitoring
and control

Figure 1-4. VSM6801+ Signal Flow Diagram
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Chapter 2
Installation

Overview

This chapter describes the VSM6801+ installation process, including
the following topics:

e “Maximum 6800+ Frame Power Ratings” on page 10
e “Unpacking the Module” on page 11

e “Setting Jumpers” on page 12

e “Installing 6800+ Modules” on page 14

ACaution

Before installing this product, read the 6800+ Series Safety
Instructions and Standards document that ships with every
FR6802+ Frame Installation and Operation Manual, or can
be downloaded from our website. This safety booklet
contains important information about the safe installation and
operation of 6800+ series products.

See the FR6802+ Frame Installation and Operation Manual for
information about installing and operating an FR6802+ frame and its
components.

See the 6800 Series Frames and Power Supply Installation and
Operation Manual for information about installing and operating a
6800/7000 series frame.

VSM6801+ Installation and Operation Manual 9



Chapter 2: Installation

Maximum 6800+ Frame Power Ratings

The power consumption for the VSM6801+ module is typically less
than 5 W.

Table 2-1 describes the maximum allowable power ratings for 6800+
frames. Note the given maximums before installing any 6800+ modules
in your frame.

Table 2-1. Maximum Power Ratings for 6800+ Frames

Max. Frame |Number | Max. Power
.?80%"' Frame Power of Usable | Dissipation
yp Dissipation | Slots Per Slot
FR6802+XF 120 W 20 6W
(frame with AC power
supply)
FR6802+XF48 105 W 20 525W
(frame with DC power
supply)
FR6802+QXF frame | 120 W 20 6W
(with AC or DC power
supply)

10 VSM6801+ Installation and Operation Manual



Chapter 2: Installation

Unpacking the Module

Preparing the Product for Installation

Before you install the VSM6801+, perform the following:
e Check the equipment for any visible damage that may have

occurred during transit.

e Confirm receipt of all items on the packing list. See “Checking the
Packing List” for more information.

* Remove the anti-static shipping pouch, if present, and all other

packaging material.

o5
2 Note

Contact your Customer Service representative if parts are

missing or damaged.

* Retain the original packaging materials for possible re-use.

See “Unpacking/Shipping Information” on page ix for information
about returning a product for servicing.

Checking the Packing List

Table 2-2. VSM6801+ Packing List

Ordered Product

Content Description

VSM6801+

One VSM6801+ front module

One VSM6801+ back connector
overlay (for use with a 6800/7000
series frame)

One VSM6801+ Installation and
Operation Manual

VSM6801+SR

One VSM6801+SR standard
single-slot, 5-BNC back connector
(For use with an FR6802+ frame)

VSM6801+DR

One VSM6801+DR standard
double-slot, 10-BNC back connector
(For use with an FR6802+ frame)

VSM6801+ Installation and Operation Manual
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Chapter 2: Installation

Setting Jumpers

The VSM6801+ module has two jumpers, J1and J3.

» Jumper J1 allows you to select either Local control or Remote
control.

» Jumper J3 allows you to select either Manual or Automatic mode
selection for NTSC/PAL-B.

Figure 2-1 shows the location of the two jumpers.

Local/remote Manual/automatic
jumper (J1) jumper (J3)

Figure 2-1. Location of the J1 and J3 Jumpers

Setting the J1 Jumper for Local or Remote Control

" Note

You need to configure modules for local or remote operation prior to
power-up. To change the configuration, first remove power from the
module, reset the jumper, and then reapply power.

Follow this procedure to set the J1 jumper for either local or remote
control:

1. Locate jumper J1 on the module (beside the extractor handle).
Figure 2-1 shows the standard location of the J1 jumper.

12 VSM6801+ Installation and Operation Manual



Chapter 2: Installation

2. Place a jumper on pins 1 and 2 to set the module for Local control,
or pins 2 and 3 to set the module for Remote control. See
Figure 2-2.

Local control setting Remote control setting

Figure 2-2. The J1 Settings for Local and Remote Control

5
2 Note

The white triangle on the module near the jumper pins indicates pin
1.

Setting the J3 Jumper for Manual or Automatic Selection
Follow this procedure to set the J3 jumper for either manual or
automatic selection:

1. Locate jumper J3 on the module. See Figure 2-1 on page 12.

2. Place a jumper on pins 1 and 2 to set the module for Auto selection,
or pins 2 and 3 to set the module for Manual selection. See
Figure 2-3.

Auto selection setting Manual selection setting

Figure 2-3. The J3 Settings for Manual and Automatic
selection

5
2 Note

The white triangle on the module near the jumper pins indicates pin
1.

VSM6801+ Installation and Operation Manual 13



Chapter 2: Installation

Installing 6800+ Modules

There are three types of modules:
e Single-slot back connectors

* Double-slot back connectors
*  Front modules

Back connectors come in two sizes: double-slot and single-slot. You
can install a VSM6801+ module in an FR6802+XF, FR5702+XF48,
FR6802+QXF, FR6802+DM or 6800/7000 series frame.

ACaution

Before inserting, removing, or replacing a back module, you must
power down the frame. Failure to do so could result in damage to
the frame, modules, or power supply.

These modules require no specialized installation or removal
procedures. However, if you are installing both front and rear modules,
ensure that the back module is installed first before plugging in the front
module. Likewise, ensure that the front module is unplugged from the
frame before removing the rear module.

e See the FR6802+ Frame Installation and Operation Manual for
information about installing and operating an FR6802+ frame and
its components.

e See the 6800+ Safety Instructions and Standards Manual for
important information about safely installing your module.

Once you have installed your VSM6801+ modules, you can connect
them to the appropriate input and outputs.

Installing 6800+ Modules into a 6800/7000 Series Frame

Follow these steps to install 6800+ modules into a 6800/7000 series
frame. (The 6800/7000 series frames have a back panel already in
place. There is no need to install an individual back connector into this
type of frame.)

All modules are hot-swappable and can be installed with the power
supply either turned on or turned off.

1. Pull out the finger-release screws on the right and left side of the
front panel, and then open it.

14
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Chapter 2: Installation

2. Locate the front module slot that corresponds with the matching
back connector, and then slide the module into the guides.

ACaution

Do not mix front modules and back connector modules. The
front module must mate with its corresponding back
connector; otherwise, you may damage the module.

See Figure 2-4 for a 1RU horizontal installation illustration and
Figure 2-5 for a 2RU vertical installation illustration.

Figure 2-5. 2RU Installation of a Module

The module is properly seated when its edge is flush with the guide
edge and the extractor handle closes.

VSM6801+ Installation and Operation Manual 15



Chapter 2: Installation

ACaution

To prevent overheating during general frame operation and
maintain proper airflow, keep the front panel closed and all
back connector slots covered during operation.

3. Close the front panel to ensure proper frame ventilation.

Once you have installed the VSM6801+ module, you can connect it to
the appropriate input and outputs. See Figure 1-2 and Figure 1-3 on
page 6.

16
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Chapter 3
Operation

Overview

This chapter describes how to operate the VSM6801+ using card-edge
controls only. See the following documents for information on how to
operate this product remotely:

* + Pilot Lite User Manual for serial control interface

e CCS™ Navigator™, Pilot™ CoPilot™ or RCP-CCS-1U Remote
Control Panel Manual for Ethernet control interface

The following topics are discussed in this chapter:
¢ *“Understanding Card-Edge Controls” on page 18
e “LEDs and Alarms” on page 22

VSM6801+ Installation and Operation Manual 17



Chapter 3: Operation

Understanding Card-Edge Controls

You can operate and monitor settings for the VSM6801+ using the bank
of DIP switches and the LED indicators on the card edge of the module.
As with all 6800+ products, external local or remote monitoring
equipment (for example, a PC or control panel) is also required.

5
2~ Note

For best results, use the available 6800+ software control options
(serial/local or Ethernet/remote) to aid in viewing, setting, and
confirming parameter values. See Appendix A for more information.

You can control the composite output by adjusting the DIP switch
settings. Each DIP switch has a corresponding LED so that you can
easily monitor the DIP switch settings from the card edge.

The VSM6801+ also has one potentiometer (pot) control that you can
use to adjust the gain for the channel.

18
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Chapter 3: Operation

See Figure 3-1 for the location of these controls.

S$1 DIP switches  Gain 1 pot

J3 jumper

J1 jumper

Module Channel LEDs
Status LED

Figure 3-1. Location of the DIP Switches and LEDs

During local control, when a DIP switch is down, its corresponding
LED is on. When a DIP switch is up, its corresponding LED is off.

During remote control, the LEDs are lit according to the settings that
are applied to the module. Jumper J1 must be set to remote control in
order for you to control the module remotely. See “Setting Jumpers” on

page 12.

VSM6801+ Installation and Operation Manual 19



Chapter 3: Operation

Operating Notes

You can affect the composite output by adjusting the DIP switches. The
bank of DIP switches has the following five controls:

Table 3-1. DIP Switch Functions

DIP
Switch

Function

Description

1

STD

¢ When the MAN/AUTO J3 jumper is set to
MAN, STD controls standard selection. You
can set this switch for either NTSC or PAL-B.

«  When the MAN/AUTO J3 jumper is set to
AUTO, STD is disabled and output standard
follows input standard.

VBI

This setting controls vertical blanking. You can
set this switch for either pass or blank. A blank
setting results in blanking lines 10 to 19 and 273
to 282 in NTSC operation and lines 6 to 22 and
319 to 335 in PAL operation.

SETUP

This setting controls setup (pedestal) in NTSC
operation. When the channel is set to PAL
operation, this switch has no effect.

TEST

This setting controls color bars test signal. You
can set this switch so that the color bars test
signal is displayed at the composite output (100/
7.5/75/7.5 for NTSC and 100/0/77/0 for PAL).
This feature requires valid CCIR-601 4:2:2 video
data input.

B&W

This setting controls black and white output. You
can remove the chrominance and burst from the
channel, thereby creating black and white output.

See Table 3-2 for specific instructions for setting the DIP switches and
monitoring the LEDs.

20
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The following table identifies the DIP switch control positions and LED
indicators for each bank of DIP switches:

Table 3-2. DIP Switch Controls and LED Indicators

DIP

Switch

Switch Function | Action Position | LEDP
1 STD NTSC Up Off
PAL Down On
2 VBI Pass Up Off
Blank Down On
3 Setup On Up Off
Off Down On
4 Test Test off Up Off
Test on Down On
5 B&W Black and white off | Up Off
Black and white on | Down On

Reading the Software and Hardware Version

The current software version of your VSM6801+ module can only be

viewed using CCS software such as Navigator (via Ethernet control).

See your CCS Navigator User Manual or online help for information on
viewing software versions.

VSM6801+ Installation and Operation Manual
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LEDs and Alarms

Channel LEDs

The VSM6801+ has six channel LEDs that serve as a quick reference to
channel settings. See Table 3-3 for details about the channel LEDs.

Table 3-3. Channel LEDs

LED Function Color Description
Pres Signals if the channel is * Green: SDI input present
receiving SDI input « Off: SDI input absent
STD Signals if the selection is PAL | * Green: PAL-format
or NTSC format selection
» Off: NTSC-format
selection
VBI Signals if the vertical * Green: Blank vertical
blanking option is pass or blanking
blank « Off: Pass vertical blanking
Setup Signals if the NTSC setup is | * Green: Setup is off
(for NTSC | on or off « Off: Setup ison
operation)
Test Signals if the color bar test | = Green: Color bar test on
signal is set on or off o Off: Color bar test off
B&W Signals if the output is black | * Green: Black and white
and white or color output
« Off: Color output
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Module Status LEDs

Module status LEDs on the corner of the module light up if an error is
detected. See Figure 3-1 on page 19 for the location of these LEDs, and
Table 3-4 for a definition of the LED colors.

Table 3-4. Status LED Descriptions

LED Color Sequence

Meaning

Off

There is no power to the module; the module
is not operational.

Green

There is power to the module; the module is
operating properly.

Red

There is an alarm condition.

Amber

The module is undergoing configuration

Alarms

The VSM6801+ module does not have any card-edge alarms. Alarms
are usually logged and monitored within the available 6800+ software
control applications (for example, + Pilot Lite or Navigator). See the
appropriate software control user manual or online help for more

information.

VSM6801+ Installation and Operation Manual
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Chapter 4
Specifications

Overview

The following specification tables appear in this chapter:

“Input” on page 26

“Output” on page 27
“Performance” on page 28
“Power Consumption” on page 28
“Start-up Time” on page 28

Specifications and designs are subject to change without notice.
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Input

Serial Digital Video Input

Table 4-1. Serial Digital Video Input Specifications

Iltem Specification

Format compatibility | 4:2:2 serial component
Connector BNC per IEC169-8

Impedance 750

Return loss >18 dB from 5 MHz to 270 MHz
Signal level 800 mV £10%

Max. input cable >300m

CMRR 30 V peak-to-peak, up to 60 Hz
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Output

Serial Digital Video Output

Table 4-2. Serial Digital Video Output Specifications

Iltem Specification

Quantity 1 BNC per channel

Connector BNC per IEC169-8

Overshoot <10% (all outputs terminated)
Impedance 750

Return loss >18 dB to clock frequency

Signal level 800 mV £10%

Jitter <0.2 Ul

Rise and fall times 0.40 to 1.5 ns (as per SMPTE-259)

Composite Analog Output

Table 4-3. Composite Analog Output Specifications

Item Specification

Standards NTSC, PAL-B

Quantity 1 BNC per channel

Signal level 1V peak-to-peak, nominal (+10% adjustable)
DC offset <+100 mV

Impedance 75Q

Return loss >40 dB t0 5.75 MHz

Output quantizing

10 bits (encoding inputs 8 bits)

Frequency response

<+0.25 dB to 5 MHz

Differential gain

<1.5%

Differential phase

<1.2 degrees

Signal to noise

>54 dB RMS to 5 MHz

VSM6801+ Installation and Operation Manual
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Performance
Table 4-4. Performance Specifications
Iltem Specification
Processing delay 1.6ps
Test signal Color bar: NTSC 100/7.5/75/7.5,
PAL 100/0/75/0

Power Consumption

The power consumption for VSM6801+ modules is less than 5 W.

Start-up Time

The start-up time specification for VSM6801+ modules is less than one
second.
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Appendix A

Communication and Control

Troubleshooting Tips

Overview

Find the following troubleshooting information in this appendix:

“General Troubleshooting Steps” on page 30

“Software Communication and Control Issues” on page 32
“Hardware Communication and Control Issues” on page 36
“Contacting Customer Service” on page 36
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General Troubleshooting Steps

Follow these steps in troubleshooting 6800+ product problems:

1. Review the “Software Communication and Control Issues” on
page 32 outlined in this chapter.

2. Search this product manual and other associated documentation for
answers to your question.

5
2 Note

Associated documentation for 6800+ series products can
generally be found in the product-specific manual that
accompanies every module, in the FR6802+ Frame Installation
and Operation Manual, and in the 6800+ Safety Instructions
and Standards Manual.

Product documentation (including manuals, online help, application
notes, erratas, product release notes, and more) can be found on our
website, along with technical support information, training
information, product downloads, and a product knowledge base.

3. Contact your Customer Service representative if, after following
these initial steps, you cannot resolve the issue.

To contact Customer Service, see “Contacting Customer Service”
on page 36.
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Control and Monitoring Using CCS Software

Before using CCS software applications to control and monitor your
module, you must refresh (+Pilot Lite) or discover (Pilot and
Navigator) the module. Refresh and Discovery are the processes by
which your CCS software finds, and then connects to your module.

Refreshing Your Module Using +Pilot Lite

When using +Pilot Lite to change your VSM6801+ control parameters,
you must “refresh” the control connection between your 6800+ frame
and PC. To refresh the connection, from the +Pilot Lite menu bar, select
File > Refresh. For information about controlling a device using +Pilot
Lite, see your +Pilot Lite User Manual.

Discovering a VSM6801+ Module

To discover your module, your Pilot or Navigator software must be in
Build mode. Follow these steps:

1.

If the Discovery window is not open, click Tools > Discovery in the
main menu.

A Discovery window opens, most likely in the bottom left corner of
the screen.

Click Options, and then click Add.

Enter the IP address of the frame that contains your module, the
frame that contains your ICE6800+ module, or the frame that
contains a 6800+ETH module that provides access to your module.

Click OK to close the Add IP address window, and then OK again
to close the Discovery Options window.

Click Start.
This triggers Pilot or Navigator to run a discovery.

When your discovery is complete, Discovery Completed is
displayed in the Discovery window. To continue, click Save, to
save the contents of your discovery to the Discovery folder of the
Navigation pane.

You can now switch to Control mode by selecting Operational Mode >
Control from the main menu. Double-click VSM6801+ in the
Navigation pane. The Control window opens, displaying the module’s
controls.
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Software Communication and Control Issues

“+ Pilot Lite Fails to Communicate with Installed Modules” on
page 32

“+ Pilot Lite Does Not Find All Modules in Frame” on page 33

“+ Pilot Lite or CCS Software Application Not Responding” on
page 34

“+ Pilot Lite Cannot Control a Module Showing
in the Control Window” on page 34

“+ Pilot Lite Status Bar Reports “Not Ready”” on page 34

“CCS Software Application or Remote Control Panel Does Not
Communicate with Module” on page 35

“Alarm Query Fails When a Device Reboots” on page 35

+ Pilot Lite Fails to Communicate with Installed Modules

Confirm that the following items are not the reason for the
communication failure:

The proper module slot has not been specified (+ Pilot Lite is not
communicating with the appropriate slot). See your FR6802+
Frame Installation and Operation Manual for more information on
slot identification.

The COM port is used elsewhere (Check that the correct COM port
is configured in + Pilot Lite and that another application is not
using that COM port).

The actual frame ID does not match with the two DIP switch
settings in the back of the frame (+ Pilot Lite is not communicating
with the proper frame). See your FR6802+ Frame Installation and
Operation Manual for more information on frame ID switch
settings.

A null modem cable is not being used. Between the PC running

+ Pilot Lite and the FR6802+ frame, there should be a null RS-232
modem cable. At minimum, this requires that pins 2 and 3 are
crossed and 5 to 5 for ground.

An ICE6800+ or 6800+ETH module is installed in the frame

(+ Pilot Lite control is disabled if an ICE6800+ or 6800+ETH
control module is installed in the frame; ICE6800+ and 6800+ETH
modules are used for CCS control).

32
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* Alegacy 6800 series product is in the frame. + Pilot Lite cannot
communicate with legacy 6800 series products. They will not be
discovered or controlled by + Pilot Lite, although they can be
installed in the FR6802+XF frame and work using card-edge
controls. The module must be from the 6800+ product family.

«  Check that the back module does not have any bent pins, following
this procedure:

a. Unplug the front module.
b. Unscrew and remove the back module.

c. View the 20-pin spring connector at the bottom of the back
module.(See Figure A-1.)

20-pin
<4——connector

Figure A-1. Back Module to Front Module Connector

This connector should not have any bent or pressed pins. Even
a slightly depressed or bent pin may cause genlock issues.

d. If there are bent pins, carefully reposition them to their correct
positions.

If this is not possible, you can exchange the back module for a
new one (order part number VSM6801+DR).

+ Pilot Lite Does Not Find All Modules in Frame

If a discovery is started too soon after frame power-up, + Pilot Lite will
not find all the installed modules. Refresh + Pilot Lite (File >
Refresh), and ensure that installed modules are fully powered-up first
before discovery.
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If a module is plugged into the frame after a discovery, + Pilot Lite
does not automatically detect the module. Refresh + Pilot Lite (File >
Refresh) to discover the newly installed module.

If a Legacy 6800 series product is in the frame, + Pilot Lite will not
detect it. + Pilot Lite cannot communicate with legacy 6800 series
products. They will not be discovered or controlled by + Pilot Lite
although they can be installed in the FR6802+XF frame and work using
card edge controls. For + Pilot Lite to find a module, it must be from
the 6800+ product family.

+ Pilot Lite or CCS Software Application Not Responding

+ Pilot Lite and CCS applications such as Navigator or Pilot cannot run
on the same PC at the same time. Both applications can be installed, but
only one can be opened at a time.

+ Pilot Lite Cannot Control a Module Showing
in the Control Window

Consider these questions:

» Did you physically set the jumper for local control? If so, set this
jumper to the REM position for remote control.

* Does the card name in the control window physically match the
card type in the frame?

« Is the module properly seated in the frame? Check the positioning
of the module in its slot in the frame.

* Does the Control window indicate the device is “ready”? The
device may be powered off or disconnected from the network.

+ Pilot Lite Status Bar Reports “Not Ready”

+ Pilot Lite reports each device’s connection status in the status bar. If
the connection status message reads “Not Ready,” check the following:

« Is the module properly seated in the frame? Check the position of
the module in the frame.

* |sthe frame connected to the network? Check the device’s network
connection.

If the status bar still reports no status or “Not Ready” for the frame or
device, try restarting + Pilot Lite.
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CCS Software Application or Remote Control Panel Does
Not Communicate with Module

CCS software applications (such as Pilot, CoPilot, and Navigator) and
remote control panels require the purchase and installation of an
ICE6800+ module in an FR6802+ frame (or an ICE6800+ or
6800+ETH module in a FR6802+QXF frame) in order to communicate
remotely via Ethernet.

Alarm Query Fails When a Device Reboots

When you reboot a device connected to your PC, the alarm traffic
hitting the network may cause an alarm query request to time out and
fail. While the query does not automatically retry, it will post an “Alarm
query failed” message to the Diagnostics window.

To clear an “Alarm query failed” message, right-click inside
the Diagnostics window, and then select Refresh from the resulting
context menu.
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Hardware Communication and Control Issues

* “Frames Fail to Communicate with the PC after a Power Failure”
on page 36
e “Module Does Not Seem to Work” on page 36

Frames Fail to Communicate with the PC after a Power
Failure

You must exit the software and restart after the frame recovers from its
power failure. To restore communications between the PC and the
frames, ensure that the frames have three or more minutes to recover
from the power failure before you exit the application and restart the
PC.

Module Does Not Seem to Work

Although the following troubleshooting tips may seem obvious, please
take the time to ensure the following:

e All appropriate rear connections are securely made
e The board is securely installed (with no bent pins)
» The frame is turned on

Contacting Customer Service

We are committed to providing round-the-clock, 24-hour service to our
customers around the world. Visit our website for information on how
to contact the Customer Service team in your geographical region.
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